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Creating New Text in PageMaker 

Although most of the text you use in Page Maker publications 
will be imported from word processing files, you can also 
create new text directly in PageMaker. You most often will do 
this to create small amounts of text such as headlines and 
captions. If you want to create large amounts of text with 
PageMaker, you should use the story editor, described later in 
this book. 

To create small amounts of text, select the text tool from the 
toolbox. You can create new text blocks inside of existing 
column guides, on the pasteboard, or you can force a new text 
block to ignore existing column guides. 

To create text within the boundaries of an existing column, 
position the 1-beam cursor inside of the column guides and 
click the mouse button. The flashing insertion point will then 
appear at the left margin of the column. Begin typing to cre­
ate your text block. 

To create text outside of existing column guides, position the 
cursor outside the page margins and click the mouse button. 
The flashing insertion point will appear, and you can begin 
typing. 

To create a text block that ignores existing column guides, 
position the cursor at the upper-left comer of the text block 
you want to define, press and hold the mouse button, drag the 
mouse to define the size of the text block you want to create, 
and release the mouse button. 

To see the text block you have created, click the arrow tool 
on top of your new text. You can format and manipulate this 
text using the procedures described in Steps 8, 9, and 10. 



Step 8 

Manipulating Text Blocks () 

Step 7 described two ways to add text to PageMaker publica­
tions. Now it is time to learn more about how PageMaker 
treats text and how you can manipulate and modify text 
blocks after they have been created. 

Text Blocks 

Each unit of text in a PageMaker publication appears within 
an object called a text block. A text block can contain a single 
word of text or an entire column full of text. A single story, 
such as an imported word processing file, can flow through a 
number of different text blocks while still remaining linked as 
a single story. 

A text block is distinguished by the handlebars that appear 
above and below it when you select the text block with the 
arrow tool or the Select All command. Figure 8.1 shows two 
selected text blocks. Notice that the tab on the lower handle­
bar of the text block on the right shows a downward arrow, 
and the tab on the lower handlebar of the text block on the 
left shows a plus sign. These symbols indicate that not all of 
the text from the story the text block contains fi ts in the se­
lected text block. The downward arrow indicates that the re­
maining text has not yet been positioned in another text 
block, and the plus sign indicates that the text continues in 
another text block. 

Manipulating Text Blocks 

When you have placed a story that flows through multiple 
text blocks, you can manipulate the text flow by moving any 
of the text block handlebars. As Figure 8.2 shows, you can 
drag the handlebars up or down to shorten or lengthen text 
blocks. 
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Figure 8.1: Selected text blocks 
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Figure 8.2: Dragging the handlebar resizes text blocks 
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• To shorten one text block, select the arrow tool, click 
the text block so that the handlebars are visible, drag the 
lower handlebar upward, and release the mouse button. 
The text that is no longer visible in this text block will 
appear at the top of the next text block. 

• To lengthen a text block, select the arrow tool, click the 
text block so that the handlebars are visible, drag the 
lower handlebar downward, and release the mouse 
button. Text that was previously at the top of the next 
text block will now appear at the bottom of the cur­
rent text block. 

When you modify the size of text blocks in this way, text 
flows through all the connected text blocks, no matter how 
many pages they are on, moving up and down the text blocks. 

Repositioning Text Blocks 

You can reposition a text block simply by dragging it with the 
arrow tool. Be careful not to position the arrow on either han­
dlebar, as this will resize the text block rather than reposition 
it. If you want to move a text block to another page, drag it on­
to the pasteboard, tum the page, and then drag the block from 
the pasteboard to its new position. When you move the text 
block onto the pasteboard, make sure that no part of the 
text block handlebars touch the electronic page, or the text 
block will remain with that page. 

You can also move text blocks by cutting and pasting them 
using the commands on the Edit menu. 

If you cut and paste a text block that has text connected to 
other text blocks, the cut and paste process breaks the con­
nection. Text will no longer flow in or out of the text block 
that was cut and pasted. Text from any text blocks before and 
after this text block will remain connected as if the cut text 
block had never existed. 
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To change the width of a text block, select it with the arrow 
tool and drag one of the handles that appear on the sides of 
each handlebar (see Figure 8.3). As you drag, you will see a 
box that represents the text block size. Release the mouse 
when this box is the size you want your text block to be. 
The text will then reflow to fit this new text block size (see 
Figure 8.3). 
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Figure 8.3: Dragging on text block handles resizes text blocks 



Step9 

Character Formatting 

In this step you will learn about PageMaker's typographic 
controls. These commands are important because they affect 
not only the appearance of your publications, but also their 
readability. PageMaker provides the standard Macintosh con­
trols, such as font, size, leading, and style, with very high lev­
els of precision, as well as advanced control of tracking, 
kerning, and character spacing. 

To learn to use the commands introduced in this step, you 
should import or create some text and then practice modify­
ing the text format as this step describes. 

Character Formatting Basics 

Before applying any character formatting commands, you 
must first select the text you want to modify. (You select text 
by dragging the text tool over it.) To modify the font, size, 
leading, width, tracking, or style of your selected type, you 
can use the appropriate commands from the Type menu, or 
you can choose the Type Specs command and use the options 
in the Type Specifications dialog box. 

In general, you should use the individual Type menu com­
mands when you want to quickly change a single character 
attribute, and you should use the Type Specs command when 
you need to change more than one attribute at one time. 

To specify irregular type sizes or leadings, you must either 
choose the Other ... option in the Size or Leading hierarchical 
menus or choose the 'JYpe Specs command and enter the de­
sired value in the Size or Leading option boxes. You can 
specify type sizes in 0.01-point increments between 1 and 
650 points, and you can specify leading in 0.1-point incre­
ments between 0 and 1300. 
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You can use keyboard commands to quickly change the size 
or style of selected text. Table 9.11ists the available keyboard 
equivalents. 

Format Keystroke 

Nonnal Style Shift-Command-spacebar 

Bold Shift-Command-B 

Italic Shift-Command-I 

Underline Shift-Command-U 

Strike-through Shift-Command-/ 

Outline Shift-Command-O 

Shadow Shift-Command-W 

Next larger type size Command-Shift-> 

Next smaller type size Command-Shift-< 

1-point smaller type Command-Option-Shift-< 

1-pointlargertype Command-Option-Shift-> 

Table 9.1: Keyboard Equivalents for Text Formatting Commands 

Setting Character Width 

Use PageMaker's Set Width command on the Type menu to 
compress or expand selected type. Figure 9.1 provides ex­
amples of text modified with this command. The default com­
pression options are 70%, 80%, and 90%, and the default 
expansion options are 110%, 120%, and 130%. If you select 
the Other ... option, the Other Character Width dialog box ap­
pears, and you can specify any text width between 0.1% and 
250% in 0.1% increments . 

Use the Set Width command to achieve special visual effects, 
not to force text fill a certain space. If you need to modify 



Normal 14 Point Type 

Compressed 70% 

Expanded 130% 
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Cut and Paste into 
Layout. Need Hel Cond 
Black! 

Figure 9.1: Examples of type modified with the Character Width 
command 

text for a better fit, use the kerning and tracking commands 
discussed next. 

Kerning 
For every character (including letters, numbers, and special 
symbols) in every Macintosh font, a font designer has prede­
termined the amount of space that PageMaker will place 
before and after each character. In most cases, this predeter­
mined character spacing is adequate, but sometimes you may 
want to modify character spacing. 

• In larger type sizes, the default character spacing often 
leaves too much space between certain characters. 

• Your text will not always fit perfectly into the amount 
of space your layout provides. 

• You may want to achieve special effects for design 
purposes. 

PageMaker provides three different types of commands that 
modify character spacing. The first group of commands, 
known as kerning commands, allow you to modify the char­
acter spacing between specific text characters. Tracking com­
mands, discussed later in this step, also modify the character 
spacing, but are generally used to modify larger ranges of text 
than kerning commands and do not provide as exacting con­
trol as kerning commands. The character spacing commands, 

----
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found in the Spacing dialog box discussed in Step 10, lets 
you modify even larger ranges of text, such as entire stories. 

PageMaker offers five kerning commands, listed in Table 9 .2. 
You execute these commands from the keyboard. 

Command 

Kern together by 1/100 
of an em space 

Kern apart by 1/100 
of an em space 

Kern together by 1/25 
of an em space 

Kern apart by 1/100 
of an em space 

Clear manual kerning 

Keystrokes 

Command-Shift-Left Arrow or 
Option-Delete 

Command-Shift-Right Arrow 
or Option-Shift-Delete 

Command-Left Arrow or 
Command-Delete 

Command-Right Arrow or 
Command-Shift-Delete 

Command-Option-K or 
Command-Option-Shift -Delete 

Table 9.2: Kerning Commands 

To execute any of these commands, place the text insertion 
point between the characters you want to kern, or select a 
range of text to kern, and then use the keyboard commands 
listed in Table 9 .2. To reset kerning to its default values, use 
the Clear Manual Kerning command (Command-Option-K). 

Your monitor and current view size will affect your ability to 
see the results of your kerning on the screen, although even in 
the best situations, the on-screen appearance is only a rough 
approximation. To see the actual results of any kerning, print 
your publication on a PostScript printer. In Figure 9.2, the C 
has been kemed to surround the following letters to create a 
special effect. 
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G the spirit! 

Figure 9.2: Special effects created with kerning 

Zoom in to 200% or 400% view size to see the effects of 
manual kerning as it is perfonned. 

In addition to manual kerning, PageMaker provides an auto­
matic Pair Kerning option that you can apply to any text on a 
paragraph-by-paragraph basis. This command is found in the 
Spacing dialog box, which you access by choosing the Para­
graph command in the Type menu and then pressing the 
Spacing button. When you use the Pair Kerning option, Page­
Maker automatically applies special character spacing to all 
text that is approximately the specified type size. 

You should use Pair Kerning as the default option for almost 
every paragraph in your publications, because it considerably 
improves the appearance of your type. However, this option 
often is applied only to text over 12 points because it slows 
down the screen display. 

Tracking 
PageMaker's Track command on the Type menu lets you 
modify the character spacing for large ranges of text, such as 
paragraphs or entire stories. Tracking performs character 
spacing manipulations that are based on the point size of the 
selected text. Thus, the amount of adjustment the various 
tracking commands make to the character spacing of your 
text depends on the point sizes of the type to which tracking 
is applied. 
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PageMaker's five tracks-Very Tight, Tight, Normal, Loose, 
and Very Loose-have been designed to modify character 
spacing while maintaining maximum text legibility. Fig­
ure 9.3 shows the effects of the various tracks on a sample 
sentence. 

dckrin trndreit in wlputa teesse vel ilium dolore e u 
dolor in hendreit in wlputa te esse vel ilium doloce e u 
dolor in hendreit in vulputa te esse vel ilium 
dolor in hendreit in vulputa te esse vel ilium 
dolor in hendreit in vulputa te esse vel ilium 

Very tlgllt 
ngllt 
Normal 
Loose 
Very loose 

Figure 9.3: Examples of PageMaker's tracking options 

By default, PageMaker applies the No Track Option to all 
text in your publication. Applying any tracking command, 
even Normal, alters the character spacing of your text. After 
applying any of the tracking commands, return your text to its 
original character spacing by using the No Track command. 

Using the Track command is the best way to change the 
amount of space consumed by text in your publication. If 
your text is running long, applying the Tight or Very Tight 
track often will allow you to fit all of the text into the avail­
able space. Be careful when applying different Track com­
mands to different stories, because the visual balance of your 
publication may be disturbed. Whenever possible, apply one 
Track command to all body text in your publication and 
one Track command to all headlines. 



Step 10 

Paragraph Formatting 

In this step you will learn to use PageMaker's paragraph for­
matting commands to control such elements as text align­
ment, paragraph indents, character spacing, and paragraph 
rules. You will also learn how to use tabs. As with character 
formatting, paragraph formatting is best learned by practicing 
these commands on some sample text. 

Controlling Text Alignment 

Any paragraph can be set left justified, right justified, fully 
justified, centered, or force justified using the Alignment 
commands in the Type menu or the keyboard equivalents 
listed in Table 10.1. To apply these commands, you must se­
lect some or all the paragraphs you want to modify. 

Command Keystroke 

Left justification Command-Shift-L 

Right justification Command-Shift-R 

Full justification Command-Shift-J 

Forced justification Command-Shift-F 

Centering Command-Shift-C 

Table 10.1: Keyboard Equivalents for Alignment commands 

Keep in mind that PageMaker aligns text relative to the width 
of the text block, which may or may not be coincident with 
column or ruler guides. To see the width of the text block, se­
lect the text with the arrow tool. If the width of the text block 
is incorrect, modify the text block width by dragging the 
handles of the text block handlebar. 

You will 
use the 
Alignment 
commands 
frequently, 
so you 
should 
learn the 
keyboard 
shortcuts 
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Controlling Paragraph Spacing 

As with most Macintosh word processors, you can specify 
the left, right, and frrst-line margins for each paragraph in 
your publication. To change the paragraph margins, select the 
text you want to modify and choose the Paragraph... com­
mand from the Type menu. This will display the Paragraph 
Specifications dialog box, shown in Figure 10.1. 

ParDgreph speclficDtlons 

Indents: 
Left ~Inches 
First ~Inches 
Right~ Inches 

Rllgnment: I Left I 
Options: 

Paragraph space: 
Before~ Inches 

After ~Inches 

DlctlonDry: I US English I 

ll OIC g 
( cancel ) 

( Rules ... ) 

(spacing ••• ) 

1811Ceep lines together 0 Keep with neHt !!:] lines 

0 Column break before 181 Widow control [D lines 

0 Page breDk before 181 OrphDn control ~ lines 

0 Include In table of contents 

Figure 10.1: The Paragraph Specifications dialog box 

Use the Before and After spacing options to offset your para­
graphs from each other rather than inserting blank lines be­
tween paragraphs. The advantages of this method are that you 
have more precise control over the spacing, and you can more 
easily later modify or eliminate this spacing. 

Setting Paragraph Options 

In the lower half of the Paragraph Specifications dialog box 
are a group of check boxes that let you control how the text in 
your publication positions itself within the columns and pages 
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of your document. After you select these commands and 
close the Paragraph Specifications dialog box, the text in your 
publication is repositioned in accordance with the new option 
settings. 

• The Keep Lines Together option ensures that the se­
lected paragraph is never broken across a column or 
page; if the entire paragraph does not fit in the current 
column, it is moved to the top of the next column or page. 

• The Keep with Next option lets you specify that 1, 2, 
or 3 lines after the last line of the current paragraph 
will appear on the same page as the last line of the 
current paragraph. If the specified lines will not fit, 
then the end of the current paragraph is moved to the 
top of the next column or page. This option often is 
used to keep introductions together with lists and to 
keep graphics and figure captions from being sepa­
rated. After selecting the Keep with Next option, enter 
1, 2, or 3 in the option box to specify the number of 
lines that you want kept together. 

• The Column Break Before and Page Break Before op­
tions specify that the selected paragraph always move 
to the top of a new column or page. These options are 
most often applied to headlines or subheadings. 

• The Widow Control and Orphan Control options spec­
ify the minimum number of lines from a paragraph that 
must be kept together at the end of a page or column or 
at the top of a page or column. If you do not use these 
options, PageMaker may break a paragraph across two 
columns so that a single line appears alone on the last 
line of a column (creating a window) or at the top of a 
column (creating an orphan). Selecting these options 
and entering a value of 2 or 3 into the option boxes 
instructs PageMaker not to leave single text lines alone 
at the bottom or top of pages. 

----
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Using the Widow Control and Orphan Control options adds a 
professional touch to your publications. 

Controlling Character Spacing 

Step 9 introduced two ways of modifying character spacing: 
kerning and tracking. You can also change the amount of 
space between text characters in Page Maker by modifying the 
options in the Spacing dialog box, which you access by click­
ing the Spacing button in the Paragraph Specification dialog 
box. Figure 10.2 shows the Spacing dialog box. 

Word space: Letter space: 

Minimum ~% Minimum ~% 
Desired ~% Desired ~ % 

MaHimum ~% Maaimum ~% 

Figure 10.2: The Spacing dialog box 

These spacing options allow you to change the amount of 
space between the letters and words in the currently selected 
paragraphs by specifying percentages of the nonnalletter and 
word spacing. Both the Letter Space and Word Space options 
have three parts: Minimum, Desired, and Maximum. The 
Minimum and Maximum options affect only justified text. 

The default Word Space settings are Maximum: 50%, De­
sired: 100%, and Maximum: 200%. These settings cause 
PageMaker to apply normal word spacing (100%) in most 
cases, but to range between 50% of nonnal word spacing and 
200% of normal word spacing when justifying text. To 
tighten the text in your paragraphs, change the Desired Word 
Space option to a value less than 100%. 
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Use fairly narrow ranges of values for the Minimum and 
Maximum Word Space options. The default range of 50% to 
200% can cause your text to appear very tight in some places 
and very loose in others. Reducing the range by entering 75% 
as the Minimum value and 150% as the Maximum value 
eliminates most wide variations in word spacing and makes 
the appearance of your documents more consistent. 

H you specify full justification, PageMaker will apply word 
spacing outside of the boundaries specified by your Minimum 
and Maximum settings if necessary to fully justify text. 

The default Letter Space settings are Minimum: -5% (5% less 
than normal), Maximum: 25% (25% more than normal), and 
Desired: 0% (normal letter space). Because changes in letter 
spacing can dramatically alter the legibility of your text, you 
should change these options with care. When working with 
justified type, modify the Minimum and Maximum values to 
control the amount of character space manipulation used to 
achieve justification. To tighten or loosen any text, change the 
value of the Desired option, moving it positive or negative by 
a few percentages. 

Adding Paragraph Rules 

You can add lines above or below any paragraph using Page­
Maker's paragraph rules option. Paragraph rules are prefer­
able to lines drawn with the horizontal line tool because they 
remain in place as the paragraph to which they are connected 
reflows. 

To specify paragraph rules, select the paragraph to which you 
want to add lines, choose the Paragraph command from the 
'JYpe menu, and then click the Rules ... button. The Paragraph 
Rules dialog box contains two sets of options: one to control 
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the attributes of a rule above the paragraph and one to con­
trol the attributes of a rule below the paragraph. Using these 
options, you can specify the line style, color, and width. 

To control the distance above or below the paragraph where 
the paragraph rule is positioned, click the Options ... button. 
Enter values for the Top and Bottom options to specify the 
exact distance above or below the baseline of the first or last 
line in the paragraph the paragraph rule is placed. 

Holding down the Option key while clicking the OK button 
closes all of the nested dialog boxes at once. 

Using Tabs 

Using tabs in PageMaker is much like using tabs in Microsoft 
Word. If you are familiar with how Word treats tabs, you 
will have very little problem using them in PageMaker. If 
you have not used Microsoft Word, a few things about Page­
Maker's tabs might take some getting used to, but you will 
ultimately fmd them easy to use-and powerful. 

To learn how to use tabs, create a new text block and en­
ter three lines of text, each containing three numbers sepa­
rated by tabs. Select these three lines of text and choose the 
Indentstrabs command from the Type menu to display the In­
dentstrabs dialog box, shown in Figure 10.3. 

Figure 103: The Tabs dialog box 
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Above the ruler in the Indents/fabs dialog box are triangles 
pointing left and right to represent the left and right margins 
of the selected text block, and triangles pointing downward to 
represent the default tab stops for the text block. To create a 
new tab, point your cursor at the position on the ruler where 
you want the tab and click the mouse button. A new tab icon 
will appear above the ruler to represent the tab you have cre­
ated. Create three tabs: one for each of the numbers in each of 
your lines of text. 

You can specify a right, left, center, or decimal tab by click­
ing the appropriate tab icon before creating your tab, and you 
can specify a tab leader by using the pop-up menu that ap­
pears when you select the Leader option. 

Click OK to close the lndents/fabs dialog box, and the num­
bers in your sample text block will position themselves ac­
cording to the tabs you specified. H you are not satisfied with 
these tab locations, choose the Indents/Tabs command again 
and adjust the tab markers. 

To move a tab, drag the tab icon from one position above the 
ruler to another. To delete a tab, drag the tab icon from above 
the ruler completely out of the dialog box and release the 
mouse button. You can also add, delete, or move tabs by using 
the pop-up menu that appears when you select the Position 
option and entering specific values in the Position option box. 

You can also use the Indents/fabs command and dialog box 
to modify the left, right, and first-line margins of the selected 
paragraph. To modify these margins, drag the margin tri­
angles on the lndents/fabs dialog box ruler. 

----
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Importing Graphics 

This step describes how to import graphics into PageMaker. 
PageMaker can use virtually any type of Macintosh graphics, 
including bit-mapped graphics, Encapsulated PostScript 
graphics, and scanned images. Graphics can be positioned in 
a fixed location, or they can be set in relation to a specific 
section of text so that they automatically move if that text is 
moved. 

To learn how to create graphics in PageMaker, see Step 12. 
To Jearn various ways to manipulate graphics, see Step 13. 

Beginning the Import Process 

The Place command was introduced in Step 7, when we dis­
cussed how to import text. This same command is used to 
import graphics, and it is used in almost exactly the same way. 

1. Choose the Place command from the File menu. 

2. Locate the graphic file you want to import to Page­
Maker and highlight its name in the scrolling window. 

3. Click the OK button or double-click the file name. 
PageMaker will import the selected graphic. 

4. The cursor will change to one of the graphic placement 
icons shown in Figure 11.1. The type of icon that ap­
pears depends on the type of graphic file you have 
imported. 

5. Position the graphic placement icon at the upper-left 
comer of the place where you want your imported graph­
ic to appear. Then click the mouse button. The graphic 
will now flow into place. 
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ll5 Blt·mapped graphic Icon 
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~~~ EPF graphic Icon 

rii TIFF graphic Icon 

Figure 11.1: The graphic placement icons 

You can place graphi~s using the same drag-placing method 
you use to place text. With the graphic placement icon dis­
played, press and hold down the mouse button and drag to 
create a box representing the size and position you want for 
your imported graphic. Release the mouse button, and the 
graphic will appear in the space you have defined. Note that 
the graphic may be distorted in order to fill the box you have 
defmed. Figure 11.2 shows a placement box being defined 
with the bit-mapped placement icon. 

Types of Graphics 

You can import four types of graphic files into PageMaker: 

• MacPaint-format files containing bit-mapped images. 
These are created by many software packages, includ­
ing painting applications such as MacPaint and Super­
Paint, image processing programs, scanning software, 
and some drawing packages. The majority of clip art 
you can buy exists in MacPaint-format files. 

• PICT-format files containing object-oriented graphic 
images. These are created by drawing applications 
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Figure 11.2: Creating a box to drag-place an imported graphic 

such as MacDraw IT and Canvas, as well as by some 
scanning software. A few PICT-fonnat clip art pack­
ages are available. 

• Encapsulated PostScript files (BPS files) containing 
high-resolution images. These are created by software 
such as Aldus FreeHand and Adobe Illustrator. Increas­
ingly, clip art is available in this fonnat. 

• TIFF (tagged image file fonnat) files containing scan­
ned images. These are created primarily with scanning 
software, but also with image-editing software such as 
Adobe PhotoShop and Digital Darkroom. 

You can select files of these types in the Place dialog box and 
import them using the procedure described earlier in this step. 

If you have graphic images that are not stored in one of these 
types of files, you may be able to use those graphics in 
PageMaker. Any graphic that you can copy to the Macintosh 
Clipboard or paste into the Macintosh Scrapbook can be 
transferred into PageMaker. To do this, 

1. Open the application that contains the graphic you 
want to transfer to PageMaker. 

----
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2. Select the graphic and choose the Copy command from 
the Edit menu. 

3. Choose Scrapbook DA from the Apple menu and paste 
the graphic into the Scrapbook with the Paste com­
mand. Close the Scrapbook. 

4. Quit the application (if you are not using MultiFinder) 
and launch PageMaker. Open the publication in which 
you want to insert the graphic. 

5. Choose Scrapbook DA from the Apple menu, position 
the graphic, and choose the Copy command from the 
Edit menu. Close the Scrapbook. 

6. Choose the Paste command from the PageMaker 
Edit menu. 

Independent versus Inline Graphics 

Graphics in PageMaker can exist in two forms: as independ­
ent graphics or as inline graphics. 

Independent graphics are independent objects, unrelated to 
any text block-you can move them anywhere on the current 
page or pasteboard, and they will not move unless you move 
them. Inline graphics, on the other hand, are embedded in a 
text block, like graphics you paste into your word processor. 
Inline graphics cannot be freely moved; they are constrained 
by their place in the text block. If you change the text above 
an inline graphic, the graphic will flow to a new position 
along with the rest of the text in the text block. 

Any graphic that can be imported into PageMaker can be ei­
ther an independent graphic or an inline graphic. You deter­
mine how a graphic will be used when you import it, and you 
can change independent graphics into inline graphics, and 
vice ve~sa, at any time. 
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Imported graphics will always be added as independent 
graphics, unless you select the text tool when you import the 
graphic. H you set the text cursor within a text block when 
you import a graphic, you determine whether the imported 
graphic will be an independent graphic or an inline graphic 
by selecting the corresponding radio button option in the 
Place dialog box. Figure 11.3 shows the options as they ap­
pear in the Place dialog box when the text cursor has been set 
in a text block before the Place command was selected. 

To create an inline graphic, choose the text tool, set the cursor 
in an existing text block, and then use the Place command to 
import a graphic. Leave the As Inline Graphic option selected 
in the Place dialog box. The imported graphic will be placed 
at the location of your text cursor. 

Inline graphics can be placed on blank lines or on the same 
lines as text. You can apply paragraph formatting commands 
to inline graphics to control their margins and their relation­
ship to the text above or below them (using the Keep op­
tions). You can select an inline graphic with either the arrow 
tool or the text tool. Use the arrow tool to select inline graph­
ics when you want to resize them. Use the text tool to select 
inline graphics when you want to cut or copy them. 

To change an inline graphic into an independent graphic, se­
lect it with the text tool, choose the Cut command from the 

Ploce: 
® Rs independent graphic 
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Figure 11.3: The Place options 
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Edit menu, select the arrow tool from the toolbox, and choose 
the Paste command from the Edit menu. 

To change an independent graphic into an inline graphic, se­
lect the graphic with the arrow tool, choose the Cut command 
from the Edit menu, select the text tool from the toolbox, and 
set the text cursor in the text block where you want the inline 
graphic to appear. Then choose the Paste command from the 
Edit menu. 



Step 12 

Creating Graphics 

This step describes PageMaker's built-in graphic creation 
tools. You use these tools to create simple graphics, which you 
can use as design elements for your publication pages. The 
features and commands in this step are fairly basic, but you 
will use them almost constantly when working in PageMaker. 

The most important aspect of creating lines and shapes is the 
accuracy with which you position your lines and shapes. 
Thus, be sure you understand how to use the rulers and ruler 
guides, introduced in Step 6, and how to change view sizes, 
introduced in Step 3. 

Drawing Lines 

The PageMaker toolbox offers two line tools: the horizontal 
line tool and the diagonal line tool. As mentioned in Step 2, 
however, using the Shift key with the diagonal line tool 
forces the diagonal line tool to act like the horizontal line 
tool. For this reason, you will probably fmd yourself using 
the diagonal line tool most frequently. 

To draw a line, select one of the the line tools from the tool­
box. The cursor will then appear as a crosshair. Position the 
crosshair at the point where you want to start your new line 
and press and hold down the mouse button. Drag the mouse 
to draw the line, releasing the mouse button when the line 
reaches the required length. 

Lines are sometimes called rules, both in the PageMaker pro­
gram and in the Aldus documentation. 

You can use the Line command on the Element menu to 
change the weight or style of any line created in PageMaker 
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immediately before or after you create it. The Line command 
provides eight line weights (Hairline, .5 Pt, 1 Pt, 2 Pt, 4 Pt, 
6 Pt, 8 Pt, 12 Pt) and nine line styles (Double, Thick-Thin, 
Thin-Thick, Triple, Thin Dash, Thick Dash, Fat Dash, Square 
Dot, Round Dot), plus the None and Reverse Line options. 
Figure 12.1 shows the Line command pop-up menu. 

None 
Hairline 
.Spt---

.l'fpt ---
2pt ---
4pt ---
6pt ---
Bpt -;;:: 
12pt • 

••••••• 

Reuerse line 

Figure 12.1: The Line command pop-up menu 

To change the weight or style of a line after it has been cre­
ated, you must select the line. Select lines with the arrow 
tool. Once selected, lines display handles at each end. 

Lines versus Paragraph Rules 

As mentioned in Step 10, you can also create lines using the 
Paragraph Rules dialog box. Paragraph rules are lines above 
or below text paragraphs. The most important feature of para­
graph rules is that they move along with the text paragraphs 
to which they are assigned. When you need to create lines 
above or below text, use paragraph rules. 
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Creating Shapes 

The three shape tools in the PageMaker toolbox allow you to 
create squares, rectangles, circles, and ovals. To draw a new 
shape, select one of the shape tools from the toolbox. The 
cursor will then appear as a crosshair. Position the crosshair 
at the point where you want to start your shape and press and 
hold down the mouse button. Drag the mouse to draw the 
shape, releasing the mouse button when the shape reaches 
the required size. 

After you have created a shape, use the Line and Fill com­
mands to format it. The Line command was discussed in the 
section "Drawing Lines"; the same options can be applied to 
shapes. The Fill command provides nine shades and eight fill 
patterns, as shown in Figure 12.2. 

llllll!l!lllll 
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Figure 12.2: The Fill command pop-up menu 
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Rounding Corners 

After creating shapes with the square or rectangle tool, you 
may want to change the type of comer on the shape. The 
Rounded Comers command provides six choices that you can 
apply to any square or rectangle. Figure 12.3 shows the dif­
ferent results that can be achieved using this command. 

Figure 12.3: The six rounded corners you can create with the 
Rounded Corners command 

To modify the comers on a shape, select the shape with the 
arrow tool and then choose the Rounded Comers command 
from the Element menu. The Rounded Comers dialog box 
will then appear, presenting icons for each of the six comer 
options. Click the comer you want applied to your shape and 
then click the OK button to apply your choice and return to 
the publication window. 

Creating Drop Shadow Boxes 

One common use for shapes is to create drop shadow boxes. 
Drop shadow boxes are really two overlapping boxes with 
text positioned inside of them. To create a drop shadow box, 

1. Position your text as required. You may want to reduce 
the column width of the text slightly to allow space 
for the drop shadow box. 
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2. Select the rectangle tool and draw a rectangle around 
the text. This rectangle should be evenly spaced on all 
sides of the text. Choose the Hairline or .5 Pt line 
weight using the Line command and choose Paper fill 
using the Fill command. 

3. Choose the Send to Back command from the Element 
menu to place the box behind your text. 

4. Create another box, starting at the upper-left comer 
of the text and extending to the lower-right comer, be­
yond the edge of the first box. Choose the None line 
weight using the Line command and the 40% fill using 
the Fill command. Figure 12.4 shows what your drop 
box will look like at this stage. 

5. Choose the Send to Back command from the Element 
menu to send the shadow box behind the text and the 
first box. Figure 12.5 shows the resulting drop sha­
dow box. 

Figure 12.4: A drop shadow box before the second box is sent 
to the back 

----
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Infrastroika 
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Step 13 

Manipulating Graphics 
45~ 

In this step you learn how to manipulate and modify both im­
ported graphics and those created within PageMaker. Because 
the process of creating publications is one of constant revi­
sion, graphic manipulation skills are very important. 

You can modify graphics in two basic ways: by repositioning 
and by resizing. We will examine these two methods and then 
look at two special manipulations: cropping imported graph­
ics and wrapping text around graphics. 

Repositioning Graphics 

Each graphic in PageMaker, whether imported or created us­
ing a tool from the toolbox, is a distinct object that can be 
freely positioned on any page or on the pasteboard. To move 
a graphic object, 

1. Use the arrow tool to select the object you want to 
move. When the object is selected, eight handles will 
appear around it. 

If you cannot select an object because it is covered by other 
objects, press the Command key while clicking at the object's 
location with the arrow tool. This procedure allows you to se­
lect objects that are underneath other objects. 

2. Press and hold down the mouse button while pointing 
the arrow tool to select the object. Be sure hot to posi­
tion the arrow on one of the object handles. (Clicking 
the handles resizes the object, as you shall soon see.) 

3. Keeping the mouse button down, drag the mouse to 
reposition the object. If you begin moving the mouse 
immediately after you click the mouse button, you will 
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see only the outline of the object as it is moved. If you 
hold the mouse still for a few seconds after you press 
the mouse button, you will see your object as you 
reposition it. 

4. As you drag the mouse, if you reach the edge of the 
display and still want to drag the object further, drag 
into the edge. This causes PageMaker to scroll the 
display automatically and allows you to move your 
object to any point on the current page or pasteboard, 
regardless of the current view size. 

5. Release the mouse button. The object is now in its new 
position. If you are unhappy with this position, you can 
either move the object again or choose the Undo com­
mand to move the object back to its previous position. 

You can constrain the movement of any graphic as you repo­
sition it by pressing and holding down the Shift key be­
fore you start moving the mouse. This will allow you to move 
only in the first direction you move your mouse: If you 
move horizontally, you will be prevented from moving verti­
cally, and vice versa. Constraining your movement in this 
way lets you easily keep objects aligned as you move them. 

Resizing Graphics 

You can easily enlarge or reduce the size of any graphic in 
PageMaker. You do this by selecting the object with the ar­
row tool and then using the arrow tool to drag one of the ob­
ject's handles. 

The way in which you resize the object depends on which 
handle you drag. Dragging one of the comer handles changes 
the size of the entire object, whereas dragging one of the side 
handles stretches the object in only one direction. Figure 13.1 
shows the diagonal arrow tool that appears when you drag a 
comer handle. 
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Figure 13.1: Dragging a corner handle 

You will often want to resize graphics proportionally, so that 
they do not become distorted. To do this, hold down the Shift 
key while resizing the graphic. Even if you previously dis­
torted a graphic, holding down the Shift key while resizing it 
will return it to its original proportions. 

When resizing scanned photographs, you can ensure that you 
choose an enlargement or reduction that will print at the best 
possible quality on your printer by using PageMaker's 
" magic stretch" feature. To do this, 

1. Make sure your target printer is selected in the 
Chooser. If you will be printing to a Laser Writer or to 
a high-resolution imagesetter but do not have one of 
these devices attached to your Macintosh, select the 
LaserWriter driver in the Chooser anyway. 

2. Choose the Print command from the File menu. 

----
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3. On the Printer pop-up menu, select the type of printer 
on which you will be printing your publication. (If the 
name of your printer type does not appear, you will 
have to install the proper APD files in the Aldus folder 
within your System folder.) Close the Print dialog box 
by clicking the Cancel button. 

4. Select the scanned image you want to resize and hold 
down both the Shift and Command keys while you re­
size the graphic. This procedure will cause the graphic 
to be resized only to enlargement or reduction percent­
ages that will allow it to retain its full resolution when 
it is printed on the currently selected printer. 

Cropping Imported Graphics 

There is one more way to modify imported graphics. Using 
the cropping tool, you can "cut off" portions of any edge of 
your imported graphics. The cropping tool is especially useful 
for adjusting scanned images, which may contain more 
graphic infonnation than you need to include in your publica­
tion. To crop an imported graphic, 

1. Select the cropping tool from the toolbox. 

2. Using the cropping tool, click the graphic you want to 
modify. This will cause the graphic handles to appear, 
just as when you select the graphic with the arrow tool. 

3. Position the cropping tool so that the line through its 
middle is over one of the graphic handles (see Fig­
ure 13.2). Press and hold down the mouse button (the 
cursor will tum into a 2- or 4-headed arrow) and drag 
the mouse to crop the graphic. 

Using the cropping tool on one of the comer handles lets you 
crop both horizontally and vertically. Selecting one of the 
side handles limits your cropping to only a single direction. 
After you have cropped a section of your graphic, you can 
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Figure 13.2: The cropping tool positioned over a graphic handle 

reexpose the cropped image at any time simply by using the 
cropping tool again and dragging the graphic handle in the op­
posite direction. 

After cropping a graphic, you can reposition the graphic 
within its new frame by positioning the cropping tool in the 
middle of the cropped graphic and holding down the mouse 
button. The cropping tool will then turn into the grabber hand 
tool, and moving the mouse will then move the graphic. Fig­
ure 13.3 shows this use of the grabber hand. 

Wrapping Text around Graphics 

The Text Wrap command, found in the Element menu, allows 
you to cause text blocks to automatically avoid overprinting 

----



----
78 Up & Running with PageMaker on the Macintosh 

Figure 13.3: Using the grabber hand to reposition a cropped 
graphic 

any independent graphic. You can specify that text jumps 
over a graphic, or you can specify that text wraps around all 
sides of the graphic. To use the Text Wrap command, 

1. Select an independent graphic with the arrow tool and 
then choose the Text Wrap command. The Text Wrap 
dialog box will appear, as shown in Figure 13.4 

2. Click the middle Wrap option icon. The first Wrap 
option icon allows text to overlay your graphic; it is 
used to tum off text wrapping after you have turned it 
on. The second icon causes text to wrap around the 
graphic using the measurements entered in the Stand­
off options. The third Wrap icon is used for custom text 
wraps, but it cannot be selected in this dialog box. 
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Figure 13.4: The Text Wrap dialog box 

3. The Standoff option boxes specify how far text is off­
set from the current graphic on the left, right, top, and 
bottom. You can either accept the default values or 
enter new values. 

4. Click the OK button. Your graphic will now be sur­
rounded by a thin dotted box, which is the graphic 
boundary around which text will wrap. 

Using the arrow tool, you can customize the graphic bound­
ary to cause text to wrap around any irregularly shaped ob­
ject. Do this by adding additional graphic boundary handles 
to the graphic boundary and then positioning the graphic 
boundary handles so that the graphic boundary defmes the ir­
regular path that you want the wrapping text to follow. 

The graphic boundary created by the Text Wrap command 
automatically has four graphic boundary handles: one at each 
comer. To add additional handles, select the arrow tool, se­
lect the graphic by clicking it with the arrow tool, and then 
click the mouse button at any point on the graphic boundary. 
(Click the mouse button quickly; do not press down the but­
ton and drag the mouse.) 

----
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After adding a new handle, point the arrow tool to the handle, 
press and hold the mouse button, and drag the mouse. Use 
this procedure to customize the graphic boundary. Release the 
mouse button after you have moved the handle. By repeatedly 
adding handles and repositioning them, you can create cus­
tom graphic boundaries, and therefore custom text wrapping, 
as shown in Figure 13.5. 
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Figure 13.5: A customized graphic boundary 



Step 14 

Style Sheets 

In this step you learn about style sheets, perhaps the most im­
portant productivity tool in PageMaker. You may be familiar 
with style sheets from your word processor. If you have never 
used style sheets before, you certainly will fmd them useful 
in PageMaker. 

Style sheets make it easy for you to use paragraph and char­
acter formats repeatedly and to ensure consistency throughout 
a single publication or across multiple publications. If you 
create long documents, or if you create the same type of 
document over and over again, style sheets will save you 
hours of effort and improve the quality of your publications. 

Understanding Style Sheets 

The process of applying text and paragraph formatting attrib­
utes to all of the text in a publication is essentially repetitive. 
After all, most publications use only three or four types of 
formatting, and even the most complex documents use fewer 
than a dozen different formats. Style sheets alleviate the re­
petitive nature of text formatting by letting you apply a com­
plex set of character and paragraph formatting instructions 
with a single mouse click. 

This book, for example, uses four basic types of paragraphs: 
headlines, body text, lists, and figure captions. Each of these 
uses a unique combination of text and paragraph formats. 
Without using a style sheet, the formatting process for this 
book would require the repeated application of the appropri­
ate text and paragraph attributes to each paragraph. This proc­
ess would undoubtedly be arduous, and formatting errors 
likely would be made. 

30 

Style 
sheets help 
you format 
text para­
graphs 
quickly 
and 
uniformly 



----82 Up & Running with PageMaker on the Macintosh 

Using a style sheet, however, simplifies this process dramati­
cally. We just define four styles (headlines, body text, lists, 
and figure captions) and apply these repeatedly. Enormous 
amounts of time are saved, and we ensure that each paragraph 
is formatted properly. 

Another benefit of style sheets is that they centralize the for­
matting defmitions and so allow paragraphs to be globally re­
formatted. If we decide to enlarge all the headlines in this 
book, for example, we can simply change the definition of 
our headline style to use a larger point size, and all the head­
line paragraphs to which the headline style has been applied 
will automatically be made larger. 

Defining Style Sheets 

Each new PageMaker publication automatically includes one 
style sheet with five default styles: Body Text, Caption, 
Headline, Subhead 1, and Subhead 2. You can use these 
styles as they are, modify them, or create new styles. To edit 
or create styles, 

1. Choose the Define Styles command from the Type 
menu. The Define Styles dialog box, shown in Fig­
ure 14.1, will appear. 

2. To edit one of the existing styles, select the name of 
the style you want to modify. The current attributes of 
this style will then appear below the scrolling window. 
Click the Edit button to access the Edit Style dialog 
box. Use the 'JYpe, Para, Tabs, and Hyph buttons to 
modify the options in the Type Specifications, Para­
graph Specifications, Indents{fabs, and Hyphenation 
dialog boxes, respectively. 

3. To create a new style, click the New button, enter a 
name in the Name box, and then defme style attributes 
using the 'JYpe, Para, Tabs, and Hyph buttons to modify 
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Figure 14.1: The Define Styles dialog box 
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the options in the Type Specifications, Paragraph 
Specifications, lndents/fabs, and Hyphenation dialog 
boxes, respectively. 

The Edit Style dialog box provides the Based On option, 
which makes using style sheets even easier and more pro­
ductive. The Based On option allows you to give one style all 
of the attributes of another style as a starting point. This 
Based On link then remains active, and any changes made to 
the Based On style will automatically affect styles based on 
that style. If the Headline 2 style is based on the Headline 1 
·style, for example, and you change the font for Headline 1, 
Headline 2 will also use the new font (unless you specifically 
attribute a font to Headline 2). 

You can also define styles by formatting an example para­
graph in your publication and then creating a style using the 
paragraph's attributes. To do this, set the cursor in the para­
graph you want to use as the style model. Then select the De­
fine Styles command. Choose the Selection option in the 
Define Styles dialog box. The Edit Style dialog box will then 
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appear, listing the formats used in the paragraph you selected. 
Enter a name in the Name box and click the OK button twice 
to complete the new style defmition. 

Importing Style Sheets 

Rather than creating a new style sheet, it is often easier to im­
port existing style sheets from either your word processing 
files or from other PageMaker publications. 

When importing Microsoft Word files, PageMaker automati­
cally imports all Word style sheets as well. If the Style names 
used in your Word document already exist in PageMaker, the 
PageMaker styles will be applied to the Word paragraphs. 

When you use word processing software that does not sup­
port style sheets, or that uses style sheets incompatible with 
PageMaker, you can use style name tags to apply style sheets 
when you import text. A style name tag is simply the name of 
the style that should be applied to a specific paragraph, listed 
before the paragraph and enclosed in greater-than and less­
than signs. Figure 14.2 shows some sample text containing 
style name tags. 

You can insert style name tags manually before paragraphs in 
a word processor, or you can insert them using a macro pro­
gram or glossary function. By selecting the Export Tags op­
tions in the Export dialog box, you can add style name tags to 
text that is exported from PageMaker. 

When importing text that contains style name tags, you must 
select the Read Tags option at the bottom of the Place dia­
log box. This option instructs PageMaker to remove the tags 
from the text as it is imported and to apply the named styles 
to the text. 
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<ahead>Definlng Colors 

<para> Working with colors in PageMaker is much like working with 
style sheets, as described in step 14. To begin the proecss of defining 
colors to be used in your publication. choose the Defme Colors 
command from the Element menu. This will bring up the Defme Colors 
dialog box, as shown in Figure 16.1 

<fcap>Figure 16.1: The Define Colors dialog box 

<para>Each PageMaker publication automatically inclu~es six colors; 
Paper, Black, Registration. Blue. Green. and Red. The fust three of 
these colors are used by PageMaker to display the electronic pages in 
the publication window, and cannot be deleted. or these, only the color 
Paper can be redefmed. The colors Blue. Green and Red are provided 
simply as starter colors, and can be modified or deleted as necessary. 

<nleft> You can define new colors using either of the three common 
color models, or by selecting a Pantone color. 

Figure 14.2: Text containing style name tags 

Another way to import style sheets into your publication is 
by copying them from other PageMaker files. You do this by 
choosing the Defme Styles command and then clicking the 
Copy button in the Defme Styles dialog box. Select the Page­
Maker publication that contains the style sheet you want to 
use and click the OK button. Imported style sheets will over­
write any existing style sheets, but you will be wamed·before 
any style sheets are overwritten. 

Applying Styles 

To use styles, open the style palette by choosing the Style 
Palette command from the Window menu. The style palette 
lists all styles currently defined in the current publication. You 
can resize the style palette by dragging the lower-left comer 
of the window, and you can reposition the palette by dragging 
its title bar. 

----
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To apply a style to a paragraph in your publication, set the text 
cursor in the paragraph and click the name of the style you 
want to apply. After a style has been applied, the style name 
is automatically selected in the palette when you place the 
text cursor in any paragraph. 



Step 15 

The Story Editor () 

In this step you will learn to use PageMaker's built-in word 
processor: the story editor. The story editor makes editing the 
text in your publication easy because it makes text easier to 
read, allows you to see a large section of text at once, and 
provides word processing features such as search and replace 
and spell checking. 

Opening the Story Editor 

To edit an existing story, you can access the story editor in ei­
ther of two ways: 

• Using the arrow tool, you can triple-click one of the 
text blocks in the story. 

• You can select a text block with the arrow tool, or set 
the text tool inside a text block, and then choose the 
Edit Story command from the Edit menu. 

When the story editor window opens, all of the text from the 
selected story appears in one long, scrolling window. This 
window includes all of the story's text, regardless of how 
many text blocks contain the text in the publication window. 
Figure 15.1 shows a sample story editor window. 

You can resize and reposition story editor windows just like 
any other Macintosh windows, using the size box and title 
bar. If you use a large monitor or a dual-monitor system, you 
can position story editor windows so that they do not block 
your view of the publication window. 

When you work in the story editor, PageMaker presents a 
slightly modified menu bar. The Element and Page menus are 
removed, and a new Story menu is added. Also, the Options 
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Figure 15.1: A story editor window 

menu presents few commands when the story editor is active, 
although several Option menu commands that were dimmed 
in the publication window are now available. 

Setting the Font and Type Size 

The story editor displays all text in a single font and type 
size. This makes text easier to read than it is when the screen 
displays the varied fonts and sizes used in most layouts. You 
can specify the specific font and type size used in the story 
editor in the Preferences dialog box, accessed by choosing 
the Preferences command from the Edit menu. 

While working in the story editor, you can apply any specific 
font or type size, as well as any other character attribute, to 
any selected text, but font or size changes will not be effec­
tive until you close the story editor and return to the publica­
tion window. 
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Creating New Stories 

In addition to providing a convenient way to edit text that is 
already placed in your publication, the story editor also can 
be used to create new stories. You create new stories by im­
porting text into the story editor or by using the story editor 
as a word processor when you write new text. 

From the publication window, you can open the story editor 
to create or import a new story, rather than to edit an existing 
story. Choose the Edit Story command while no text block is 
selected, and while the text tool is not positioned inside of 
any text blocks. Once inside the story editor, you can create a 
new empty story window at any time by choosing the New 
Story command from the Story menu. After creating this new 
story, you can transfer it into your layout, as described here. 

To import text from a word processing file into the story edi­
tor, choose the Import command from the Story menu. When 
you are working in the publication window, this command 
perfonns the same function as the File menu's Place com­
mand. Choosing the Import command displays the Import to 
Story Editor window, shown in Figure 15.2, which includes 
exactly the same options as the Place dialog box discussed 
earlier in this book. 

When you are working in the story editor, you use the Place 
command in the File menu (sometimes labeled Replace) to 
transfer text from the current story editor window back into 
the publication layout; you don't use it to import external text 
or graphic files. When you are working in the story editor, 
you must use the Import command from the Story menu to 
import external files. 

Importing word processing files into the story editor is an 
easy way to prescreen imported files when you are unsure of 
their content. For example, if you have a number of files with 
similar names and are unsure as to which one you want to use 
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Import to Story Editor 
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Figure 15.2: The lmport to Story Editor dialog box 

in your layout, use the story editor and the Import command 
to open the files and locate the one you want to use. You can 
then place the correct file in your publication and discard the 
unwanted files quickly and easily. 

Search and Replace 

In the story editor, you can search for specific text or for 
text that has been formatted with specific character attri­
butes or styles. You can limit your search to a specific range 
of text, search an entire story, or search all text in the current 
publication. 

1. Open a story editor window for the story you want to 
search. 

2. Choose the Find command from the Edit menu. The 
Find dialog box will appear, as shown in Figure 15.3. 

3. If you want to search for a specific word or phrase, 
enter that text into the Find What option box. Use the 
Match Case option if you want the capitalization of the 



Find 

Find what: I Lottery Tickets 

Options: 0 Match case 0 Whole word 

Search: 0 SP.CP.cte<l t<mt ®Current story 
QRII stories 

Figure 15.3: The Find dialog box 
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n Find B 
[Rttrlbutes ... ) 

text to match exactly and use the Whole Word option 
to limit your search to complete matches. To specify 
the formatting attributes of your search, click the At­
tributes button and specify the Paragraph Style, Font, 
Size, and 1YPe Style options to defme your search. 

If you specify attributes while leaving the Find What option 
box empty, PageMaker will find any text that uses the speci­
fied formatting. You can use this feature, for example, to lo­
cate each occurrence of a particular style or to find where you 
have used a specific font. 

4. Specify the range of text to be searched by choosing 
the Selected Text, Current Story, or All Stories option. 
Choosing the All Stories option instructs Page Maker to 
search all text blocks in your entire publication. 

5. Click the Find button, and the search of the selected 
text range will begin. When a match is found, the story 
editor window highlights the text that has been located. 
You can then close the Find dialog box or click the 
Find Next button to search for the next text match. 

The Find Next command, on the Edit menu, allows you to re­
peat your most recent search without changing the options in 
the Find dialog box. 
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Using the Change command, which is also on the Edit menu, 
you can find and replace any text or text attributes. The 
Change dialog box, shown in Figure 15.4, includes all of the 
same options as the Find dialog box, plus the Change To op­
tion box and the Change, Change & Find, and Change All 
buttons. 

liD Chan e 

Find what: I Candy 
~============~ 

Change to: ._I G_ra_n_ol_a ______ __, 

Options: 0 Matc:h c:ase 0 Whole word 

Searc:h: 0 S~lt-cted teHt ®Current story 
0 fill stories 

Figure 15.4: The Change dialog box 

H Find D 
Change 

(Chonge & find] 

( Change ell ] 

( Attributes ... ] 

To replace one word or phrase with another, enter the text you 
want to locate in the Find What option box and enter the text 
you want substituted in the Change To option box. Click the 
Find button, and PageMaker will search for the specified text, 
highlighting it when it is found. You can then click the 
Change button to replace the highlighted text with the text in 
the Change To option box, or you can click the Change & 
Find button to replace the highlighted text and search for the 
next occurrence of the Find What text. 

Clicking the Attributes button lets you specify the style, font, 
type size, and type style of the text you want to find and the 
text you want to replace. If you leave the Find What and 
Change To option boxes empty, PageMaker will fmd any text 
with the specified Find attributes and change the formatting 
to that specified by the Change attributes. 

To change all underlined text in your publication to bold, 
choose the Change command, leave the Find What and 
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Change To options empty, click the All Stories option, and 
then click the Attributes button. Select Underline in the Find 
Type Style pop-up menu and select Bold in the Change 
To Type Style pop-up menu. Click the OK button to close the 
Attributes dialog box, and then click the Change All but­
ton. All underlined text in your publication will be changed 
to bold. 

Spell Checking 

PageMaker's spell-checking feature lets you check the spell­
ing of any text selection, of an entire story, or of all text in the 
current publication. Suggested replacement spellings are 
automatically offered for unknown words, and you can add 
new words to your own dictionary so that they are not 
flagged as unknown in the future. 

1. Open the story editor and a story editor window that 
contains some or all of the text you want to check. 

2. If you want to spell check only a small section of your 
text, highlight this section by dragging the text cursor 
over it. 

3. Choose the Spelling command from the Edit menu. 

4. If you want to spell check only the currently selected 
text, choose the Selected Text option. If you want to 
spell check the text in the current story only, choose the 
Current Story option. To spell check all of the text in 
every story in the current publication, choose the All 
Stories option. 

5. Click the Start button. PageMaker will begin to scan 
the selected text for misspelled words. When the pro­
gram fmds an unknown word, it displays the word 
along with a list of suggested corrections, as shown in 
Figure 15.5. 
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0 Spellln 
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Search: 0 S(ll!!< lt>ll 11~ 111 ®Current story 0 All stories 

Figure 15.5: The Spelling dialog box making a suggestion 

6. If the unknown word is spelled correctly, click the 
Ignore button to leave it unchanged or click the Add 
button to add that word to your dictionary so ·that it is 
not considered unknown in future sessions. 

To replace the unknown word with one of the suggest­
ed words, select the word in the suggestion list that you 
want to use and click the Replace button. You can also 
correct the word by editing it in the Change To option 
box and then clicking the Replace button. 

After you click the Ignore or Replace button, Page­
Maker continues to check the spelling of the remain­
ing text. 

7. After all of your text has been checked, or at any time 
during the spell-checking process, you can close the 
Spelling dialog box by clicking the close box in the 
title bar. 

Closing the Story Editor 

When you are done editing text in the story editor, you can 
close the story editor windows and return to the publication 
window in several ways. 



The Story Editor 95 

• Clicking the close box in any story editor window 
closes that window. If you click the close box of the 
last, or only, story editor window, you are returned to 
the publication window. Clicking the close box of a 
story that has not already been placed in the layout 
displays the Story Has Not Been Placed dialog box (see 
Figure 15.6), where you can choose to discard the text 
in that window, add the text in that window to your 
publication, or cancel the closing operation. 

The story has not U Place g 
been placed. ( Discard J 

(Cancel) 

Figure 15.6: The Story Has Not Been Placed dialog box 

• Choosing the Close Story command from the Story 
menu has the same effect as clicking the close box in 
the current story window. 

• To close any story editor window and add the edited 
text from that window to the current layout, choose the 
Place or Replace command from the File menu. This 
command will appear as Place only when the story 
being editing has not already been positioned in the 
current layout (if it was newly created or imported). 
After you choose the Place command, you will be 
returned to the publication window, and a text place­
ment cursor will appear, allowing you to flow the text 
into your layout. 

Choosing the Replace command has the same effect as click­
ing the close box in a story editor window. Edited text from a 

----

• I 
:\ 

~~~ 



----96 Up & Running with PageMaker on the Macintosh 

story that has already been placed is always automatically 
added to the publication. 

• To return to the publication window without closing 
any of the current story editor windows, choose the 
Edit Layout command from the Edit menu. 

• You can also return to the publication window, or bring 
any story editor window to the front, by choosing the 
window title from the Window menu. In addition, you 
can use the Window menu to return to the story editor 
from the publication window. 



Step 16 

Using Color 

This step introduces the ways in which you can use color in 
your PageMaker publications. PageMaker supports both spot 
colors and process colors, so you can create documents that 
can be reproduced using either spot-color printing techniques 
or four-color-process printing techniques. 

You can take advantage of PageMaker's color features even if 
you are working on a black-and-white Macintosh system. 
Any color information you specify will be stored in the file 
and will print properly either to a color printer or as color 
separations. 

Defining Colors 

Working with colors in PageMaker is much like working with 
style sheets, as described in Step 14. To begin the process of 
defining colors to be used in your publication, choose the De­
fine Colors command from the Element menu. The Defme 
Colors dialog box will appear, as shown in Figure 16.1 

Define colors 

Color: 

P11per 
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Rl'glslr81/on 
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~ 
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Figure 16.1: The Define Colors dialog box 
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Each PageMaker publication automatically includes six De­
fine Colors options: Paper, Black, Registration, Blue, Green, 
and Red. The first three are used by Page Maker to display the 
electronic pages in the publication window and cannot be de­
leted. Of these three, only Paper can be redefined. The colors 
Blue, Green, and Red are provided simply as starter colors and 
can be modified or deleted as necessary. 

To define a new color, click the New button. The Edit Color 
dialog box will appear, as shown in Figure 16.2. This dialog 
box allows you to defme (or edit) a color using either of the 
three popular color models-Red Green Blue, Hue Lightness 
Saturation, or Cyan Magenta Yellow Black-or to pick a col­
or from the Pantone color library. 

Edit color 

Name: ._I R_ed _____ ___, 

Model: 0 RGB 0 HLS ® CMYK 

Cyan: @:=! "4 10 DM1~i~!iM¢1 
Magenta: I• oo I "4 IOG~@~i@a[ 1¢1 
Yellow: I• oo I ~ IOfii'r~Ata•ll 1¢1 
Bleck: @:=! "4 101 l!Ji\lli'Ji~U¢1 

Figure 16.2: The Edit Color dialog box 

H OK ~ 
Cancel ) 

To begin defming a new color, select a color model by using 
the Model option radio buttons, or click the Pantone button, 
select a color from the scrolling color list, and click the OK 
button to close the Pantone dialog box. Edit your color either 
by entering values into the color-component option boxes 
or by manipulating the horizontal scroll bars that appear next 
to each color component. H you are working on a color moni­
tor, the color you have created will appear to the right of the 
color-component options. 
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When you are satisfied with your new color, enter a name for 
the color in the Name option box. Your color name can in­
clude up to 32 characters, although some special characters 
cannot be used in color names. When you are satisfied with 
your color name and defmition, click the OK button to return 
to the Defme Colors dialog box. 

You can now continue to defme new colors, or you can edit 
any of the existing colors by selecting their names and click­
ing the Edit button. This will reopen the Edit Colors dialog 
box, where you can modify the selected color by manipulat­
ing the color component definitions. 

From the Defme Colors dialog box, you can also import col­
ors that have been created and stored in another PageMaker 
publication. To do this, click the Copy button and then select 
the PageMaker file that contains the colors you want to im­
port. If any of the colors you import use names identical to 
those already defmed, a dialog box will appear warning you 
that the imported colors will replace those currently defined. 

Storing all of your frequently used colors in a single Page­
Maker publication and using the Copy button to import them 
into any publication you create saves time and ensures con­
sistency among your publications 

Applying Colors 

The first step in using colors in your publication is to display 
the color palette (see Figure 16.3). To do this, choose the 
Color Palette option from the Windows menu. Like other pal­
ettes, you can resize the color palette, and you can reposition 
it by dragging its title bar. 

To apply a specific color to text in your publication, select the 
text with the text tool and then choose the color you want to 
apply from the color palette. You can also select the color you 
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Figure 16.3: The Color menu 

want to apply using the Color option pop-up menu in the 
Type Specifications dialog box. 

If you are using a style sheet to format your text, define a 
color for the style sheet using the Color option in the Type 
Specification dialog box. 

To apply a color to a graphic element, select the graphic ele­
ment with the arrow tool and then, on the color palette, click 
the name of the color you want to apply. 

To quickly edit the defmition of any color, hold down the 
Command key and click the color name on the color palette. 
The Edit Color dialog box will appear, where you can modify 
the definition of the color. 

Color and the Printing Process 

When deciding which colors to use in your publication, keep 
in mind the type of printer on which your publication will ul­
timately be printed and the reproduction method that will be 
used to duplicate your fmal prints. 
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If you will be printing your final PageMaker files to a color 
PostScript printer, you can use any color available in Page­
Maker. The quality of your fmal result will depend on theca­
pabilities of the color printer. 

If your publication will be printed using spot-color printing 
techniques, you probably want to use only two or three col­
ors. You may want to select only Pantone colors because they 
are widely used in the printing industry. Your on-screen de­
sign will provide a fairly accurate representation of the final 
results. When you use spot-color printing, the specific color 
used to represent a spot color on the screen does not really 
matter; you could use the default colors of red and blue on the 
screen, print your separations, and then instruct your printer 
to use any two colors in the actual printing process. 

If your publication will be output to four-color-process sepa­
rations and printed using a four-color-process printing tech­
nique, you are free to use as many on-screen colors as you 
like, but you must pay careful attention to your color selec­
tion as it will directly affect your fmal printed publications. 
Producing four-color-process publications requires you to keep 
your color monitor calibrated, work with a color service bur­
eau that knows how to produce accurate separations from 
PageMaker, and select a printer who has experience working 
with desktop-produced separations. 

Importing Color Graphics 

Using the Place command, you can import color TIFF, EPS 
(encapsulated PostScript files) PICT, and MPNT (MacPaint) 
files into PageMaker. These files will appear in color in Page­
Maker using the full spectrum of colors available on your 
system. 

Imported color graphics will usually print along with the 
black separation when you produce spot-color separations 

----
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directly from PageMaker. Using Aldus Pre Print, a process­
color separation utility sold separately, you can separate color 
EPS and TIFF files for four-color-process printing along with 
your entire PageMaker publication. 



Step 17 

Printing 

This step describes the process of printing PageMaker files 
to PostScript-equipped laser printers. PageMaker provides a 
wide range of printing options, allowing you to control en­
largement and reduction, crop marks, spot-color separations, 
font downloading, and much more. 

Using the Chooser 
As in other Macintosh applications, you should use the 
Chooser desk accessory to select your target printer before 
you choose the Print command from the File menu. This pro­
cedure is especially important when you are working in Page­
Maker, because the dialog box displayed when you choose 
the Print command depends on the type of printer currently 
selected in the Chooser. 

For the best possible results, you should use a PostScript laser 
printer when working with PageMaker. For the remainder of 
this step, we will assume that you have selected the Laser­
Writer icon in your Chooser. If you have selected some other 
type of printing device, the printing dialog boxes and options 
will vary slightly from those described here. 

The Print Dialog Box 
To begin the process of printing your publication, choose the 
Print command from the File menu. The Print To dialog box, 
shown in Figure 17 .I, will then appear. The name of the spe­
cific printer currently selected in the Chooser will appear on 
the top line of this dialog box. 

Most of the options presented in the upper portion of this 
dialog box should be familiar to you from other Macintosh 
applications. The last few options, however, are unique to 
PageMaker. 

To print 
a copy 
quickly, 
set only 
the Page 
Range and 
Printer 
options 
and then 
click the 
OK button 
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Print to: Rocket Raccoon 

Copies: II] 0 Collate 0 Reuerse order 

Poge range: ® Rll 0 From 1~1 to [!I] 
Paper source: ®Paper tray 0 Manuel feed 

Scaling: ~ % 0 Thumbnails, ~ per page 

Book: ® Print this pub only 0 Print entire book 

II Print ]I 
Cancel ) 

-"· .. ···-···· .. -·--·· 

Printer: I LaserWriter II NTH I 
Size: 8.5 H tt.D Inches 
Print area: 8.0 H 10.8 Inches 

Paper. I Letter I 
Tray: ® SL'I£'C1 

Figure 17.1: The Print To dialog box 

Use the Scaling option to reduce the pages of your publica­
tion to 25 to 99 percent of normal size, or to enlarge pages by 
101 to 1000 percent. If your enlarged pages are bigger than 
the paper on which you are printing, you will want to use the 
Tile option, found in the Aldus Print Options dialog box, de­
scribed later in this step. 

Use the Thumbnails option to print pages that contain mini­
ature versions of several publication pages on a single page. 
You can control the number of miniature pages printed with 
the Thumbnails option by entering a value between 2 and 64 
for the Per Page option. 

The Print To dialog box provides two Book commands: Print 
This Pub Only and Print Entire Book. These commands are 
available only if you used the Book command to defme a 
list of PageMaker publications that are related to the cur­
rent publication. The Print This Pub Only option limits your 
printing to the current PageMaker file. Selecting the Print En­
tire Book option instructs PageMaker to print every file in the 
Book dialog box book list when you click the Print dialog 
box OK button. 
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Use the Printer command pop-up menu to select the specific 
printer type on which you will be printing. The printer names 
in this list are those for which APD files were installed during 
PageMaker installation. Figure 17.2 shows a sample Printer 
command pop-up menu. 

General 
RST Turbolaser/PS 
Color General 
LoserWriter II NT 

../ laserlllriter II NTH 
LoserWriter Plus 
Linotronic 1 00/300 
Linotronic 500 
OMS ColorScript 1 00 
Silentwriter 

Figure 17.2: The Printer com11Ulnd pop-up menu 

After selecting your printer name, choose a paper size using 
the Paper option. Then confirm that the dimensions displayed 
next to the Size and Print Area options are correct. 

If you need to add more printers to your pop-up menu, copy 
the required APD files from your original PageMaker disks 
into the APD folder, located in the Aldus folder within your 
System folder. 

After setting the options in the Print To dialog box, you can 
click the OK button to begin the printing process, click the 
Options button to modify the Aldus print options (described 

· next), click the PostScript button to modify the PostScript 
printing options (described later in this step), or click the 
Cancel button to return to the publication window without 
printing. 

----
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speed up 
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printing 

The Aldus Print Options Dialog Box 

Clicking the Options button in the Print To dialog box dis­
plays the Aldus Print Options dialog, shown in Figure 17 .3. 

Aldus print options 

181 Proof print 181 Crop marks 
0 Substitute fonts 0 Smooth 
181 Spot color ouerlays: I All colors I 
OKnockouts 

II OK ij 
[Cancel I 

0 Tile: 0 ~an mil ®Auto IWP.rllll) l~llnches 
0 l>rint blonk pogP.s 

Euen/odd pages: ®Doth 0 Et•en 0 Odd 

Orientation: ®Tell 0 Wide Image: 0 lnuert 0 Mirror 

Figure 17 J: The Aldus Print Options dialog box 

The Proof Print option instructs PageMaker to replace each 
imported graphic in printed publications with a box contain­
ing an X. This replacement allows your pages to print much 
more quickly. 

If your publication includes color, you may want to use the 
Spot Color Overlays and Knockouts options. Use the Spot 
Color Overlays option to instruct PageMaker to print one or 
more of the colors that have been applied to text or graphic 
elements on separate pages. Using the adjoining pop-up 
menu, you can choose to print spot-color separations for all 
colors in the publication or for only one specific color. 

When printing spot-color separations, use the Crop Marks op­
tion to print special alignment marks and the name of each 
separation color on each separation. 

When creating spot-color separations, you can use the 
Knockouts option to avoid the problems associated with inks 
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mixing during the printing process. When you use the Knock­
outs option, portions of text or graphic elements that are over­
lapped by other text or graphic elements are eliminated from 
the separations. Eliminating these elements allows the over­
printing text or graphic element to be applied directly to the 
paper, avoiding the problems associated with applying one 
ink directly on top of another. 

Use the Tile option when printing publication pages that are 
larger than the paper on which they are being printed. In most 
cases, you will want to use the Auto Overlap tiling option, 
which automatically calculates where to position page breaks. 

When you are done manipulating the options in the Al­
dus Print Options dialog box, click the OK button to return to 
the Print To dialog box. 

The PostScript Print Options dialog box 

To access the PostScript Print Options dialog box, shown in 
Figure 17 .4, click the PostScript button in the Print To dialog 
box. This dialog box includes a number of useful options. 

PostScript print options n Print ]I 
0 Download bit-mapped fonts [ cancel ) 
0 Downlood PostScript fonts 
0 Make Aldus Prep permanent raesetl 
0 Uh~w 111st err<ll" me~sc1ge ~ 
1811nclude lmoges 
0 TIFF for position only 
181 Print PostScript to disk: [rue name ... ) 

®Normal 0 1:1)5 0 For separations 
1811nclude Aldus Prep 

Figure 17.4: The PostScript Print Options dialog box 

----
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The Download Bit-Mapped Fonts and Download PostScript 
Fonts options control whether or not these fonts are automati­
cally transferred to your printer as needed. When PageMaker 
automatically downloads fonts, the Printer Status dialog box 
informs you of each font being downloaded, as shown in 
Figure 17.5. 

/ 

II Downloading PostScript® font: ltcEras-Bold. 

II 
II Font Melior Is not found on LaserWrlter Plus, substituting Courier. 

Figure 17.5: Two sample Printer Status dialog boxes 

Use the TIFF for Position Only option to output only low­
resolution versions of your imported TIFF files. This op­
tion saves time when you are printing proof copies of your 
files. Deselect this option when printing fmal pages or color 
separations. 

Use the Print PostScript to Disk option to create PostScript 
files: to transfer files to a service bureau for high-resolution 
output, to create an EPS file of a single PageMaker page that 
can then be used as a PageMaker graphic or by another soft­
ware application, or to prepare separation files for Aldus Pre­
Print or another four-color separation utility. 

1. To create a PostScript file, select the Print PostScript to 
Disk option. 

2. Choose the type of PostScript file you want to create 
by clicking the Normal, EPS, or For Separation radio 
button. 

3. Click the File Name button to specify the file name and 
location of the PostScript file you will create. 
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4. When creating Normal PostScript files, click the In­
clude Aldus Prep option if your seiVice bureau has 
instructed you to do so. In most cases, you will not 
need to select this option. 

5. Click the OK button to begin creating a PostScript file. 
The file will be saved with the name and location you 
specified. 

----
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Indexes & TOCs 

This step introduces two advanced PageMaker features: in­
dexing and table of contents generation. You will use these 
features most often when you create long documents consist­
ing of several PageMaker publication files, such as books 
or manuals. Used properly, these features eliminate hours or 
even days of manual effort and make your publications more 
useful to their readers. 

The Book Command 
When working with documents that include more than one 
PageMaker file, you must use the Book command to create a 
logical relationship between the files before you create an in­
dex or table of contents. 

1. Open the PageMaker file in which you want to position 
your index or table of contents. 

2. Choose the Book command from the File menu. 
The Book Publication List dialog box, shown in Fig­
ure 18.1, will appear. 

Boole publication list 

!...> = DataDrlue 

lei! Encyclpedla B ... 
0 RppendiH R 
0 Chapter I 

IQ 
D Chapt er 2 
I 

D Chapter 4 
D Chapter 5 

lei 0 TOC 

Insert 

Remoue 

Moue up 

Eje< t l OK B 
OJiiV!J [ Cancel ) 

Boole list: 

TOC IQ 
Chapter 1 
Chapter 2 
Chapter 3 
Chapter 4 
Chapter 5 
RppetidTH R [Mnup duwn) 

Figure 18.1: The Book Publication List dialog box 
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. • 
Often you will want to create one new publication file for 
your index and another new file for your table of contents . 
You will have to use the Book command in each file. 

3. The Book Publication List dialog box is used much 
like the Apple Font/DA Mover. In the left window, 
select the name of the first PageMaker file that will ap­
pear in your publication and click the Insert button. 
This file name will then be added to the Book List win­
dow. Repeat this procedure, adding each of the files 
that are part of the fmal publication, until the Book List 
window contains the names of all the files you want in­
cluded in your index or table of contents. 

4. Click the OK button to close the dialog box. You are 
now ready to create your index or table of contents. 

Marking Index Entries 

To include a word or phrase in your index, you must mark the 
word or phrase each time it appears in your publications and 
then specify the reference that will appear in the index. Page­
Maker refers to each word or phrase in your index as a topic 
reference. Topic references can contain up to 50 characters. 

To include text as a topic reference, select the text with the 
text tool and then choose the Index Entry command from 
the Options menu. This will bring up the Create Index Entry 
dialog box, shown in Figure 18.2. This dialog box is used to 
edit the topic reference text and to specify the range of pages 
to which the index reference refers. 

The text you selected when you chose the Create Index Entry 
command appears in the first Topic option box. You can edit 
this text, if necessary. If you cannot see all of the text, use the 
arrow keys to scroll right or left within the option box. 



Create lndeH entry 

Topic: Sort: 

I Heort Attack~ I ~ I 
~I ======~I ~I ======~ 
~I ------~1 ~I ------~ 
Ronge: 0 Current poge 

Indexes & TOCs 113 

u 01, n 
(Cancel ] 

(Topic ... ] 

(H-ref ... ) 

0 To neHt style change 
®To neHt occurrence of style: I Headline I 
0 For neHt [!] paragraphs 
0 Cross-reference (H-ref) 

Reference ouerrlde: D Bold D Italic 0 Underline 

Figure 18.2: The Create Index Entry dialog box 

If you have already created index entries for this topic, either 
in the current file or in other files on your book list, you can 
verify the spelling or terminology of the index entry by click­
ing the Topic button and locating the existing entries in alpha­
betical lists. 

The Range option you select determines the listing that ap­
pears for the topic reference when it appears in the index. 
Five range options are available; 

• The Current Page option causes the page number on 
which the topic reference appears to be listed in the 
index. 

• The To Next Style Change option lists the range of 
pages starting with the page on which the topic refer­
ence appears and ending with the page that contains 
the first paragraph after the topic reference that uses a 
different style sheet. This option is most often used to 
sp_ecify a range of pages ending with the next headline 
or subhead. 
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• The To Next Occurrence of Style option is similar to 
the To Next Style Change option. You select a specific 
style sheet, and when this style sheet occurs, the page 
range ends. 

• The For Next _ Paragraphs option lists a range of 
pages starting with the page on which the topic refer­
ence appears and ending with the page that contains 
the nth paragraph, where n is a value specified in the 
option box. 

• The Cross Reference option directs inquiries regarding 
one index entry to another index entry. For example, a 
book about boxing might have many indexed refer­
ences to Muhammad Ali. You could use the Cross Ref­
erence option to direct readers who look up ''Cassius 
Clay" to the Muhammad Ali references. Use the X-ref 
button to select a specific cross-reference topic. 

Click the OK button to close the Create Index Entry dialog 
box. If you are using the story editor, a small black diamond 
will appear before the text you have selected as your topic 
reference. 

You can quickly create an index entry by selecting text and 
then pressing Shift-Command-; (semicolon). This procedure 
lets you index the selected text without opening the Create 
Index Entry dialog box, using the default Range option. 

Editing Index Entries 

To edit a single index entry, open a story editor window that 
contains your indexed text. Select the black diamond that ap­
pears in front of the index entry you want to modify and 
choose the Create Index Entry command. The Create Index 
Entry dialog box will appear, and you can then modify any 
aspects of the selected index entry. 
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To review all of the index entries you have made in the cur­
rent publication, or in all publications that will be part of your 
index, choose the Show Index command from the Options 
menu. The Show Index dialog box, shown in Figure 18.3, 
will then appear. H you have used the Book command to de­
fme the publications included in your fmal document, this 
dialog box will include all index entries from all publications. 

Show lndeH 

lndeH section: IE) 
Lovol 1 

H-ref ••• 

Lovol 2 

[Go to neHt) 

Lovol 3 

Edit ... 

Figure 18.3: The Show Index dialog box 

n OK 11 

[Cancel) 

Roforonco 

The Show Index dialog box lists, for one letter of the alphabet 
at a time, each index entry and the assigned reference. To 
move between letters of the alphabet, use the Index Section 
pop-up menu or click the Go to Next button. To modify a spe­
cific entry, select it with the arrow tool and then click the Edit 
button. You can then change any of the options in the Create 
Index Entry dialog box. 

Generating an Index 

Once you have defmed and edited your index entries, you are 
ready to compile and place your index. Open the publication 
file in which you want to lay out your index, verify that the 
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Book command has been used to specify all related publica­
tions, and then choose the Create Index command from the 
Options menu. The Create Index dialog box, shown in Fig­
ure 18.4, will then appear. 

Create lndeH n OK B 
nue: l1i:i1!@1i--W¥.;mmm1UI ( cancel ) 

0 R•~t>lltte et«l~ Uog todPll 
~ Include book publications (Format ... ] 

~ Remoue unreferenced topics 

Figure 18.4: The Create Index dialog box 

H this is the first time you have created an index for the cur­
rent publication, click the OK button. PageMaker will then 
compile your index. H you are using the layout view, a text 
placement icon will appear, and your new index can then be 
positioned just like any other imported story. H you are using 
the story editor when you choose the Create Index command, 
a new story window. will appear, which you can then place 
into your publication by choosing the Place command from 
the File menu. 

Once your index is in position, you can freely edit the text 
in your index. Remember, however, that if you later reindex 
your publication, all of your text edits will be overwritten by 
the new index. 

Creating a Table of Contents 

For PageMaker to create a table of contents for your publica­
tion, you must first mark each paragraph-which usually will 
be a heading or subheading-that should be included. Do this 
by placing the text cursor in the paragraph you want to mark, 
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choosing the Paragraph command from the 'JYpe menu, and 
then selecting the Include in Table of Contents option. 

If you use style sheets to format your long documents, as you 
likely will, you can usually mark all the paragraphs that 
should be included in your table of contents by selecting the 
Include in Table of Contents option in the paragraph defini­
tion for your headlines and subheads. 

After you mark your paragraphs, you are ready to generate 
the table of contents. To begin, open the file in which the 
table of contents will be laid out and confirm that all associ­
ated publications are listed in the Book Publication List dia­
log box. Next, choose the Create TOC command from the 
Options menu. The Create Table of Contents dialog box will 
then appear. If necessary, modify the options in this dialog 
box. Then click the OK button. 

If you are working in the publication window, a text place­
ment icon will appear. Place the text as you would any im­
ported story. (If you are working in the story editor, a new 
story window containing the table of contents will be 
opened.) The table of contents story will include the complete 
text of all marked paragraphs, plus the number of the page on 
which each paragraph appears. 

Once the table of contents is placed, you can edit or format 
the table of contents text as required. As with indexes, any 
editing performed on the table of contents will be lost if you 
later generate a new table of contents. For this reason, it is 
best not to edit the table of contents until all publication 
changes that affect final page numbering are complete and the 
table of contents is re-created. 

PageMaker automatically creates styles on the style sheet to 
format the table of contents, and you can modify the table of 
contents formatting by editing this style sheet. 

... 1 air ·<w.:m;m~:~ 

Oi -
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Linking () 

This step introduces powerful file management commands 
that you can use to manually or automatically update im­
ported text or graphics files. These commands are useful for 
publications being created in workgroup situations, and 
for publications that are regularly updated, such as price lists 
and brochures. 

Understanding Links 

When you import a text or graphics file into PageMaker, you 
normally keep a copy of the file as part of your publication 
file. But suppose you (or someone else) modifies the original 
text or graphics file, and you want to bring that updated file 
into your PageMaker publication. PageMaker's link manage­
ment commands allow you to control whether and when up­
dated versions of your text and graphics files are used in your 
publications. 

The Links Command 

To experiment with the Links command, open a publication 
file that includes several imported text and graphics. Choose 
the Links command from the File menu. The Links dialog 
box, shown in Figure 19.1, will appear. 

The Links dialog box lists each imported file along with the 
page number on which it appears and the current link status. 
Five different link status conditions exist, each of which is 
indicated by a specific character or icon that appears before 
the file name. In addition, selecting a particular element dis­
plays the current link status below the scrolling element 

30 
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Links I[ OK B 
Document Kind Page 

New Employee Train. 6/2 ••• Tent 3 
Sterlold Info Tent 4 
T/URR/Logo.eps Encapsulated PostScript 6 
Graphic PI CT 1 
Graphic PICT 2 
Graphic PICT 3 
Graphic PICT 4 

( Link Info... ] (Link options ... ] Update ] ( UpdotP. oil 

Figure 19.1: The Links dialog box 

window. The link symbols are as follows: 

• No symbol. Either the external file has not been modi­
fied since it was imported, or no link exists for this 
element. 

• Question mark. PageMaker is unable to locate the ex­
ternal file. You can reestablish this link, as described 
later in this chapter. 

• Solid black diamond. The external file has been modi­
fied since it was imported, and this element will be 
updated automatically the next time your publication 
is opened or printed or when you press the Update 
button. 

• Open diamond. The external file has been modified, 
but the element is not set for updating. To update the 
link, press the Update button. 

• Open triangle. The external file has been modified, and 
the version of the file currently in the publication also 
has been modified. 
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Below the scrolling element list are four buttons: Link Info, 
Link Options, Update, and Update All. The Link Info button 
performs exactly like the Link Info command, described in 
the next section. The Link Options command brings up the 
Link Options dialog box, which controls whether copies of 
the linked element are stored in the publication file, and 
whether updated elements are imported automatically. 

The Update button replaces the current version of the selected 
element with the version currently stored in the linked file. 
The Update All button replaces all elements with updated ver­
sions from the linked files. 

The Link Info Command 

To verify or modify the link status of any particular text or 
graphic element in your publication, select the element with 
the arrow tool and choose the Link Info command on the Ele­
ment menu. The Link Info dialog box, shown in Figure 19.2, 
will then appear. 

Link Info: TIURR/Logo.eps 

I (g) Training Logos I 
Cl RT Logo.eps IQ 

I 'I 

to 

Eject I[ Lint H 

ortue ( Cancel ) 

too> (g) Training Logos 

Looatt011: Training l1190s :T /VNUlogo.~s 

Ktnd: EMaps;uhlt~ Postscript 

St&•:1&a< 

Plao•d:6/25190, 10:51 PM 

~t mo4tfWd:713t/89, 10:00 N1 

ratn11al data modlfled:N~ 

Figure 19.2: The Link Info dialog box 

----
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The scrolling file list at the left side of this dialog box in most 
cases displays the folder and file to which the selected ele­
ment is currently linked. The right side of the dialog box pro­
vides information about the linked file, including the date and 
time it was placed in PageMaker and the date and time that 
the disk file was last modified. 

To update or modify the link, select from the scrolling list the 
name of the file you want to link. Then click the Link button. 
You can link either an updated version of the original file or 
an entirely different file. The contents of the newly linked file 
will replace the previously linked file in your publication. 

The Link Options Command 

You can use the Link Options command in two different 
ways. If you select the Link Options command when you 
have selected no specific element, the Link Options: Defaults 
dialog box appears, as shown in Figure 19.3. 

Link options: Defaults 

TeHt: 
181 Store< Ot>IJ in I>IJI>Ii•:<lti(HJ 

0 Update automatically 
0 1\INt l>t~tom IJI)dOtlfl~l 

Graphics: 
181 Store copy In publication 

D Update automDtlcolly 
0 1\INt bi~tort~ IJI>Ii11Un1.1 

I[ OK fi 
[C8iiUiJ 

Figure 19.3: The Link Options: Defaults dialog box 

This dialog box presents three options for text elements and 
three options for graphics elements. The Store Copy in Publi­
cation option determines whether imported files are copied 
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into the PageMaker file or accessed directly from the external 
disk file. You cannot tum off this option for text files; they 
must be stored in the publication. When you select the Up­
date Automatically option, PageMaker accesses the most re­
cent version of your text or graphics files each time you open 
or print your publication. If you select the Alert before Updat­
ing option, you will be warned before any automatic updates 
occur so that you can cancel or acknowledge them. 

H you select the Link Options command after you choose a 
specific text or graphics element, the Link Options dialog box 
appears, as shown in Figure 19.4. This dialog box presents 
the same options as the Link Options: Defaults dialog box, 
but these options affect only the selected text or graphics 
element. 

You can save considerable disk space by not storing large 
graphics files in your publications. Whenever you do store graph­
ics files, however, keep careful records of the external 
graphics files, as you will need them each time you open or 
print your publication. 

Link options: T/URR/Logo.eps 

181 S1<tnl < 1>1>1.4 In I>UbllcaHon 
0 Update eutometlcolly 

0 IUert lu~tort~ updoting 

Figure 19.4: The Link Options dialog box 

([ OK II 
~ 
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The Table Editor 

This step introduces the Aldus Table Editor, a separate utility 
program that is included along with Aldus PageMaker. The 
Aldus Table Editor is a specialized tool that helps you easily 
create complex text tables, which you can then transfer into 
Page Maker. 

The Aldus Table Editor is automatically installed in the 
same folder as your Aldus PageMaker 4.0 application during 
installation. 

Creating a New Table 

After launching the Aldus Table Editor, select the New com­
mand from the File menu. The Table Setup dialog box will 
appear, as shown in Figure 20.1. Enter the number of col­
umns and rows you will require in your table, the total size of 
the table you want to create, and the gutter space between 
table text and cell borders. Click the OK button, and your 
new table will be created. 

Tobie setup 

Number of columns: E=:J 
Number of rows: EJ 

" OK n 
( Cencel J 

Tobie size: CJ by "-'l~,_____,llnches 

Gutter In Inches: Column:EJ 

Row: EJ 

Figure 20.1: The Table Setup dialog box 
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Entering Data into the Table 

You can enter text directly into your table from the keyboard, 
or you can import data from any text or tab-delimited file. 

To enter text into any cell in your table, select the text tool 
from the Table Editor toolbox and click the mouse button 
when the cursor is in the desired cell. Type the desired data 
into the cell. Press the Tab key to move one cell to the right 
(or to the first cell in the next row). Press the Return key to 
move one cell down (or to the first cell in the next column). 

To import data from a text file, choose the Import command 
from the File menu and select the file you want to import. 
Choose the Replacing Entire Table option if you want the im­
ported data to overwrite any existing data in your table. 
Choose the Into Selected Range option to place the imported 
text into specific cells. 

Most spreadsheets allow you to save data in text or tab­
delimited fonnat so that you can transfer it into the Aldus 
Table Editor. 

Formatting Tables 

The Aldus Table Editor provides a number of commands that 
allow you to customize your table. A few of these are de­
scribed here. 

• To change the width of a column or the height of a 
row, position the cursor on the line between the column 
or row labels (the cursor will tum into a two-headed 
arrow), press the mouse button, and resize the col­
umnorrow. 

Alternatively, you can select a row or column and use 
the Column Width or Row Height commands from the 
Cell menu. 
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• To add borders to any cell, select the cell or cells to 
which you want to add borders and choose the Borders 
command from the Cell menu. The Borders dialog box 
will appear, as shown in Figure 20.2. 

• To format the digits in any cell that contains numbers, 
select the cell or the row or column that contains the 
numbers. Then choose the Number Format command 
from the Cell menu. The Number Format dialog box, 
shown in Figure 20.3, will appear. Choose the number­
ing format you want applied to the selected numbers. 

_Bo_r_de_rs _________ ~ OK lJ 

Apply neHt line style to: (cancel) 

Perimeter: 181 Top 181 Right 

181 Left 181 Bottom 

Interior: 0 Horizontals 

0 Uertlcels 

Figure 20.2: The Borders dialog box 

_Nu_m_b_e_r _ro_rm_a_t ______ H OK Jl 

Format type: 

0 
0.00 
#,##0 
#,##0.00 
$#,##0;($#,##0) 
$#,##0.00;($#,##0.00) 

Format: General 

(Cancel) 

Figure 20.3: The Number Format dialog box 
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• To add any numbers together, select the cells that con­
tain the numbers and choose the Sum command from 
the Cell menu. The addition cursor will then appear. 
Click the cell that you want to contain the sum. 

• Use the commands in the Type, Lines, and Shades 
menu to modify the text formatting, border, and fill 
pattern of any selected cells. 

Saving and Exporting 

You can save files created in the Aldus Table Editor by using 
the Save and Save As commands. However, files saved in this 
manner cannot be imported to PageMaker or used by any 
other application. 

To save tables in a format that can be used in PageMaker, 
you must save them in a special format using the Export 
command. 

1. Choose the Export command from the File menu. The 
Export to File dialog box, shown in Figure 20.4, will 
appear. 

You can save files in either PICT or Text Only format 
if you want to import them into PageMaker. Use the 
PICT format if you want your table to retain all of its 
formatting. The only limitation of the PICT format is 
that you will not be able to edit the table in PageMaker. 
If you save the table in the Text Only format, you will 
lose your table formatting, but you will be able to mod­
ify the table in PageMaker. 

2. Choose either the Entire Table or the Selected Cell 
Range option to determine which section of the current 
table you want to save. In most cases, you will want to 
save the entire table. 
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EHport to file 

~· OK ~ 
Ia som I ~ [cenc:el] 

Cl SOlll MnnftPsto ~ ~ C) Peper Drlue 
Cl S01R.I990 

File format: 
®PICT 
0 TeHt only (Tab delimited) 

K5 
EHport: 
® Entire table 

11 991 Sales Proj.Tbl 0 Sele< tt'd coli range 

Figure 20.4: The Export to File dialog box 

3. Enter a name for your file, use the Drive button and the 
Folder bar to choose a location for your file, and click 
the OK button. 

4. Open the PageMaker publication into which you want 
to import the table. Then choose the Place command. 
Select the table file you saved and click the OK button. 
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ftle compression, 22 
Fill command, 69 
Find command, 90 
Find What option, 90 
For Next Paragraphs option, 114 
fonnatting. See also publication 

design 

paragraphs, 53-59 
text, 47-52 
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Go to Page command, 17 
grabber hand, 9, 16, 77 
graphic placement icons, 62 
graphics 

applying colors, 100 
creating, 67 
cropping imported, 76 
importing, 61 
repositioning, 73 
resizing, 74 
wrapping text, 77 

graphics programs 
importing from, 61-62 
PageMaker-compatible, 62-63 

Guides option, 30 

handlebars 
for grapl)ics, 73-80 
for text, 43-46 

hardware requirements, 1-2 

Ignore button, 94 
Import command, 89 
Import to Story Editor dialog 

box,89 
importing 

colors, 99, 101 
graphics, 61 
style sheets, 84 
text, 37-42 
word processing files, 37, 89 

Include in Table of Contents 
option, 117 

Indents/Tabs command, 58 
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Indents/Tabs dialog box, 58 
independent graphics, 64 
index entries 

editing, 114 
marking, 112 

Index Entry command, 112 
indexing, 111-116 
inline graphics, 64 
installing PageMaker, 1-3 

Keep Lines Together option, 55 
Keep with Next option, 55 
kerning, 49-50 
keyboard shortcuts, 10 
Knockouts option, 106 

layout grid, 25 
Leader option, 59 
Leading option, 47 
Letter Space option, 56 
Line command, 67-69 
lines 

drawing, 67 
style, 68 
weight, 68 

linking, 119-123 
buttons, 121 
commands, 120-122 
dialog boxes, 119, 122-123 

MacPaint format files, 62, 101 
manual text flow, 39 
margin options, 20 
master page icons, 11 
master pages, 11,31-35 

creating, 32-33 
hiding elements of, 34 
printing,31 

Match Case option, 90 
Measurement System option, 28 
menu bar, 12 
menus, 5 
mini-save, 22 
Modeloption,98 

New command, 19 
New Story command, 89 
No Track option, 52 

Open command, 21 
Open Publication dialog box, 21 
option box options, 6 
Orphan Control option, 55 
Other option, 47 

Page Break Before option, 55 
pageicons, 11-12,16,31 
Page option, 19 
page sizes, 19 
pages 

turning, 16-17 
viewing, 13-16 

Pair kerning option, 51 
Pantone button, 98 
Pan tone colors, 101 
Paragraph command, 54 
paragraph rules, 57 
Paragraph Rules dialog box, 

57,68 
Paragraph Specifications dialog 

box, 54 
paragraphs 

aligning, 53 
formatting, 53-59 

Paste Setup dialog box, 19 
pasteboard, 11-12 



PICI' format files, 62 
PICI' graphic icon, 62 
PICI' graphics, 101 
Place command, 38, 61, 89,95 
Place dialog box, 38 
Position option, 59 
Preferences command, 88 
Preferences dialog box, 28, 88 
printers 

laser, 1 
PageMaker-compatible, 1 
PostScript, 1, 101 

printing, 100-101,103-109 
color, 100-101 
commands, 103-104 
dialog boxes, 103-108 
oversized pages, 104 
reduced pages, 104 

Proof ~nt option, 106 
publication window, 11-17 
Publication design, 19-20,25-35 

question mark cursor, 10 
quitting PageMaker, 23 

radio button options, 6 
Range option, 113 
Read Tags option, 84 
Replace button, 94 
Replace command, 89, 95 
repositioning 

column guides, 26 
graphics, 73 
text blocks, 45 

Resize box, 11, 13 
resizing graphics, 74 
Rounded Comers command, 70 
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Rounded Corners dialog box, 70 
RTF file format, 37 
ruler guides, 29-30 
rulers, 11-12, 27-30 

tick marks, 29 
zero points, 29 

Rulers command, 28 
Rules button, 57 

Save As command, 22 
Save command, 21 
saving 

files, 21-23 
tables, 128 

Scaling option, 104 
scanned images, 61 
Scrapbook,63 
scroll bars, 11, 13, 15 
Search and Replace, 90 
semiautomatic text flow, 39-40 
Send to Back command, 71 
Set uft and Right Pages Sepa-

rately option, 26 
Set Width command, 48 
Show Index command, 115 
Show Index dialog box, 115 
Snap to Rulers, 29 
Spacing button, 56 
Spacing dialog box, 51,56 
spell checking, 93 
Spelling command, 93 
Spot Color Overlays option, 106 
spot colors, 97 
Standoff option, 79 
Start Page# option, 19 
Store Copy in Publication 

option, 122 
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Story has not been placed dialog 
box,95 

Story Editor, 87-96 
creating new stories, 89-90 
editing with, 87 

Story menu, 87 
style palette, 11, 85 
style sheets, 81-86 

applying, 85 
colors, 100 
defining, 82 
importing, 84 

Styles palette, 13 

Table Editor, 125-129 
Table of contents, ll1, 116-117 
Table Setup dialog box, 125 
tabs, 58-59 
text blocks, 42-46 

creating,42 
changing width, 45 
handlebars, 43 
repositioning, 45 

text 1-beam cursor, 9 
text tool, 8 
Text Wrap dialog box, 79 
Thumbnails option, 104 
TIFF for Position Only 

option, 108 
TIFF graphic icon, 62 
TIFF graphics, 101 

Tile option, 104, 107 
title bar, 11-12 
To Next Occurrence of Style 

option, 114 
To Next Style Change option, 113 
toolbox 7-8, 11, 13, 67-72 
Topic button, 113 
topic references, 112 
Track command, 51 
tracking commands, 49 
type specifications, 47-56 

Update All button, 121 
Update Automatically 

option,123 
Update button, 121 

Vertical Ruler option, 28 
view sizes, 13-14 

Whole Word option, 91 
Widow Control option, 55 
word processors 

PageMaker-compatible, 37 
importing from, 37-39 

Word Space option, 56 
wrapping text around graphics, 

77-80 

zero point, 29 
zoom box, 11-12 
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